IT Essentials

All you need to know about IT at UCL for new members of staff.
Who we are and what we do

Central IT services are provided for you by Information Services Division.

You can:

- Find out more about what we offer online: www.ucl.ac.uk/isd
- Follow us on twitter – @uclisd
- Find out more about us at: www.ucl.ac.uk/isd/about
- Keep up to date with news and developments: www.ucl.ac.uk/isd/news

www.ucl.ac.uk/isd
Access central IT systems
Your user ID and password is your key to our IT systems. Keep your details safe!

www.ucl.ac.uk/isd/userid-passwords

Credentials
You will be issued with a personal user ID and password. These credentials will give you access to UCL wide IT facilities.

Your user ID is 7 characters long and looks something like: ucaaxxx

Your password
We’ve set an initial password for you to get you up and running. But you should now change it to something only you know. Do this using the MyAccount service: https://myaccount.ucl.ac.uk

You will need to change your password every 150 days. Reminders will be sent to your email account.

Register with us
Sign up for the User Authentication Service. It will allow you to obtain a new password quickly in the event that you forget your current one. It may seem unimportant now, but in the future, you’ll be glad that you did!

https://myaccount.ucl.ac.uk/uas-register/

Confused about how to log in?
For all systems you need your UCL password, but you may need to enter your user ID in different formats:
Email (Outlook Web App): <userID>@ucl.ac.uk
Staff desktop and student computer rooms: <userID> only
Wireless: <userID@ucl.ac.uk>
Top tip!
How to choose a password

Do:
choose a password that is 8 characters long

Don’t:
base your password on a dictionary word

Do:
use at least three of the following different types of characters:

• Lowercase
• Uppercase
• Numbers
• Symbols

Don’t:
base your password on your personal details

Need an example?

A simple approach is to think of a memorable sentence (8 words long), then form a password by taking one or more characters from each word. Remember to use upper and lowercase letters and punctuation! So, for example:

Phrase: Chickens carried him off, kicking and screaming!
Password: CcHo,kaS

Phrases that can be visualised – however silly they might be – are often easiest to remember. Use your imagination, but not our example!

Note: there are certain symbols and characters that are not acceptable. Please see online guidance for help with choosing an acceptable password. www.ucl.ac.uk/isd/acceptable-password
Check your email & schedule meetings

live@UCL is the email and calendar service for staff and students.

www.ucl.ac.uk/isd/email-calendar

Email & Calendar

Your email address

When you log in to your email account, your first message will be from the Postmaster informing you of your email address. It will be based on your name, e.g. f.bloggs@ucl.ac.uk

Different ways to access

At work: Use Outlook to access your UCL email and schedule meetings with colleagues.

At home: Log in via the web using Outlook Web App (OWA).

On the move: Synchronise your mobile device with your email and calendar.

When you log in to OWA...

Remember: you must append your user ID with @ucl.ac.uk. e.g. ucaaxxx@ucl.ac.uk
Top tip!
How to set a signature

According to UCL protocol, signatures should contain your work title, department, as well as phone number, email address and relevant web address where appropriate.

To set one up

• **Outlook Web App (OWA)**
  Click on the **settings** button on the top-right corner and select **Options**. Select **Settings** from the left hand window pane and click on the **mail** tab.

• **Outlook 2010/13**
  In a new message window, in the **Include** group, click on the **Signature** button and select **Signatures**...

• **Outlook for Mac 2011 and 2016**
  In a new message window, select the **Message** tab. Select **Select Signatures > Edit Signatures**

Example signature

Cathy Brown
Faculty Manager
Arts and Humanities;
Social and Historical Sciences
Tel: 020 769 1347
Internal: 31347
Mobile: 07826892046
Email: cathy.brown@ucl.ac.uk
www.ucl.ac.uk/ah-shs-office

Any variations or additions to this format should be agreed by the relevant Head of Professional Services or Faculty Manager.
Connect on or off campus

eduroam is the wireless service connecting you around campus and at participating institutions. You can also connect remotely to the UCL network.

www.ucl.ac.uk/isd/get-connected

Wireless access on campus

eduroam is a free wireless service and available throughout campus.

Connection guides

Follow the instructions online on how to connect for your device. You will need your user ID and password.

Will you have guests visiting UCL?

Your visitors can also be provided wireless access through our UCLGuest service.

When you connect to wireless...

Remember: you must append your user ID with @ucl.ac.uk. e.g. ucaaxxx@ucl.ac.uk

Connect from outside UCL

The UCL Remote Access VPN Service provides a resilient, secure means of accessing private UCL corporate central services from off-site locations.

Examples of services available via Remote VPN:

- MyView
- MyFinance
- Central Filestore
- Management Systems Database Servers
- UCL MS Key Management Servers
- UCL Desktop data/applications
eduroam is a JANET Roaming Service (JRS) that enables you to use your UCL credentials (e.g. ucaaxxx@ucl.ac.uk) to access the internet from UCL or any participating institution.

The instructions for connecting are the same regardless of location. However, it is recommended you

(a) check eduroam works here at UCL and
(b) search on eduroam participating organisations
Secure your computer with free anti-virus software

Access free software & get good deals on hardware.

www.ucl.ac.uk/isd/software-hardware

Hardware purchasing

If you need new hardware, don’t run off to PC World to buy your new equipment.

On our website, we offer recommendations for corporate IT equipment. We also provide a managed desktop service (Desktop@UCL) where we will order, install and support the equipment for you.

Discounted software for home

Through UCL software agreements, you can get discounted or free software for use on personal machines.

For discounted Microsoft Windows and Office software see ucl.onthehub.com.

For other software see swdb.ucl.ac.uk and look under the licences for each product.

UCL licensed software

Download free anti-virus software plus any site-licensed software to which you are entitled from the software database.
Top tip!

Use Software Database to find out which applications are available on our desktop services and for personal use.

Go to: https://swdb.ucl.ac.uk

Search for a variety of software to discover what is available to you.

We have information on how to install and activate products, whether it’s free or needs payment.

Did you know we have resources from vendors on how to get more out of their products?
Brush up on your IT skills

Practical tools and resources to help you.

www.ucl.ac.uk/isd/training

Course Programme

We have an extensive course programme including Office and Adobe products, website content management, data analysis software, bibliographical tools and more.

Online resources

Prefer to learn at your own pace? Peruse our selection of course materials, videos and other online learning materials to help you develop your skills. Find out more overleaf.

European Computer Driving Licence (ECDL)

ECDL is an internationally recognised qualification. Gain certification of your IT skills through this accredited programme.

One to one help

We hold regular drop-in sessions during term time where you can get individual support with your IT needs.
Top tip!
Learn at your own pace: free resources for UCL staff and students with Lynda.com

Lynda offers FREE unlimited access to over 175,000 video tutorials and training courses for staff and students. Learn business, software, technology and creative skills to achieve personal and professional goals.

Lynda is available through any web browser or download the app for your app store.

www.ucl.ac.uk/lynda

Virtual Training Company (VTC)

Virtual Training Company (VTC) offers a wide range of video tutorials on Microsoft Office, Adobe products, programming, project management, graphic design, multimedia and much more.

ISD IT Training

ISD IT Training is our Moodle course containing all of the training materials and sample files used in our classroom courses as well as essential pre-learning for some sessions.

Activ Online Learning

Activ Online Learning is a Moodle course providing interactive learning materials for the Microsoft Office suite to support the European Computer Driving Licence.
You’ve won a season ticket!
just give me your password...

Don’t fall for it, visit:
www.ucl.ac.uk/informationsecurity/stay-safe
Keep your password secure!
Look after your login details. If someone else uses them, they may cause you and others a great deal of trouble. UCL will never ask you to reveal your password. Ignore all emails asking for your passwords.

Use strong passwords
To create a strong password, make sure you include a mixture of numbers, upper and lower case letters and symbols. Keep your password secure!

Ensure that your machine(s) are up to date
This includes your operating system, applications, your browser, and any plugins.

Keep your anti-virus updated and your firewall enabled

Be wary when reading your email
Do not click on any links or attachments in unsolicited email.

Back up your data regularly
Make sure your backup is not located in the same place as your working files. Put a pin code on your mobile device e.g. phone or tablet.

Learn the basics
Our Information Security Awareness course on Moodle has information on email scams, protecting data, passwords and policies. Log into Moodle, search for “Information Security Awareness”, and self-enrol.

Handling sensitive information
If you are handling confidential or sensitive information, check our guide on encryption.

Your responsibilities
As a member of staff you are bound by the UCL Information Security Policy.
Enhance your learning & teaching

Find out how technology can help the student learning experience.

www.ucl.ac.uk/isd/learning-teaching

Engage your students

We are here to help you use technology to enhance the learning of your students within and beyond the classroom. E-Learning is now widely used across UCL, through for example Moodle, our ‘virtual learning environment’, lecture recording, online assessment and feedback, voting handsets and distance learning.

UCL eXtend, our public facing learning portal can even help you engage with learners outside of UCL for Life Learning, CPD or Executive Education. We are keen to work with individuals, departments and communities such as the E-Learning Champions network to develop your ideas and enhance student learning.

Top 5 ideas popular with students:

• Record your lectures and put them online (automatically if you wish) via the Lecturecast service available in UCL’s larger lecture rooms.
• Voting handsets encourage better student engagement in large classes.
• Use Moodle to develop simple online quizzes to help students check their progress.
• The Turnitin service, also via Moodle, enables you to provide online feedback and helps check for potential plagiarism.
• Moodle forums can simplify your communications with students, and provide a space for group discussion and feedback.
Top tip!
Try Lecturecast

Lecturecast is UCL’s automated system for recording lectures and making them available via Moodle. It is very popular with students who use it to review, in detail, the content of lectures and tag segments to look at again at revision time.

You don’t have to record a whole lecture either; Lecturecast’s downloadable ‘personal capture’ software lets you make screen recordings with voice-over on your own computer. Many lecturers are using this to provide supplementary material and extra feedback to students. Some are even using this approach to experiment with ‘flipping’, creating online material for students to view materials in advance, to make the most of their face-to-face time.

How to get started

Visit the Lecturecast information page via: www.ucl.ac.uk/isd/learning-teaching

Here you can book recordings, learn how to get access to the personal recording software and find links to more detailed guides.
Your desktop

Access your desktop at work or from home.

Staff computers

Our desktop service gives you access to your files, applications and desktop from anywhere in the world as long as you have an internet connection.

Where to save your work

Keep your files safe on the central filestore which is backed up every night. You can also use a shared data area (S: drive) which can be accessed by colleagues in your department and is useful for collaborating.

Computers in lecture theatres or student computer workrooms

We provide IT and AV equipment in centrally bookable lecture theatres and computer workrooms across campus. How-to guides and support information for lecture theatres and student computer workrooms are available online.

When you log on:

You only need to enter your user ID. Do not append with @ucl.ac.uk

Remote access

Working from home or on the move? We provide services that allow you to remotely access your desktop, files, and UCL software applications and systems (see overleaf).
Top tip!
...use Desktop@UCL Anywhere for remote access to your files and folders.

Remote access using Desktop@UCL Anywhere

Desktop@UCL Anywhere gives you access to UCL services remotely. There are two ways to access Desktop@UCL Anywhere, you can either:

- Install the Citrix receiver, which is a piece of software installed on your computer that allows you to connect to Desktop@UCL.

- Alternatively you can connect directly to Desktop@UCL from your web browser.

How-to guides and further help can be found on our web pages.

www.ucl.ac.uk/isd/services/computers/remote-access/desktop
Print, copy, scan

This is called the print@UCL service.

Send your print job from our desktop service or your own computer or laptop. Then use any device around campus to print your document. You can also use any device to copy, scan and fax quickly and easily.

You can even email your print job from your mobile device and collect from any print device connected to the service.

print@UCL in your department?

Check whether your department is using the print@UCL service (at present not all departments are). If not, contact your local IT support team to find out the printing arrangements for your department.

The first time you use print@UCL...

Register your UCL ID card

The first time you swipe your ID card at the printer, you will need to register on the system. To register, enter your UCL user ID and password using the printer’s key pad. Your user ID does not need to be appended with @ucl.ac.uk.

Any time after that:

All you need to do is swipe your UCL ID card to log in.
Top tip!
How to print two sheets to a page

Go to Print
(Ctrl + P or File > Print)

Choose Options or Properties and select Document Options.

On the Page Layout tab, select 2 pages Per Sheet.

Select OK and Print.
We develop, deliver and operate services to assist UCL researchers in meeting their objectives at each stage of the research lifecycle, from funding through to publication and dissemination.

**Your UCL profile**

IRIS (Institutional Research Information Service) is the internal and public research portal for UCL. Use IRIS to maintain your own researcher profile and to identify the research activities of others.

**Your publications list**

The Research Publications System (RPS) is designed to provide UCL researchers with a single point of entry for keeping their publications up to date. It integrates with both IRIS and Discovery, UCL’s open access full-text repository.

**Assistance with other Research IT Services**

Find out how else we can help you. Our range of services include: Research Computing, Research Software Development and Research Data Services.

**Training**

We run various courses ranging from an Introduction to High Performance & High Throughput Computing, and Software Carpentry Workshops.
Top tip!
**Talk to us about the service**

Talk to us about how the Research Data Service can provide safe, resilient storage for your research project data.

We can provide support for coordinated end-to-end research ‘workflows’ encompassing the use of both data storage and computational resources. We can help you plan in advance how you are going to manage, store and preserve data beyond the lifetime of your research project and allow its re-use and citation by the wider academic community.

By using the Research Data Storage and Research Data Archive services you will fully comply with both UCL’s and UK funding bodies’ policies and requirements to make publicly funded research data freely accessible to the widest possible audience, removing this burden from you.

**Email:** rits@ucl.ac.uk
Disability IT Support

Do you have a disability and need advice on assistive technology?

Assistive technology

Do you have a disability and need advice on assistive technology? Contact the Disability IT Support Analyst who can advise you on software and hardware to meet your needs.

Ergonomics

Do you have questions about workstation health or ergonomics? Learn about the simple adjustments that can make your workstation more comfortable.

Disability IT Support Analyst

The Disability IT Support Analyst is here to help you. Whether you have a temporary challenge which is affecting your work or an long term issue, the Disability IT Support Analyst can provide support.

The Student Enabling IT Suite

For students with disabilities, we have a dedicated computer workroom equipped with an up-to-date range of software and technology.

For access and to book inductions please contact the Disability Service on either disability@ucl.ac.uk or contact 0207 679 0100.

Contact details

M.Farmer
Email: ditso@ucl.ac.uk
Tel: 020 7679 2809 (int. 32809)
Location: SENIT Suite, Wilkins Building, B10
Top tip!
Are you sitting comfortably?

Bad habits and incorrect posture can lead to aches and pains. Maintain good posture at your workstation by following these tips.

- Viewing distance between 16–24 inches
- Top of monitor at or slightly below seated eye level
- Home row of keys should be at or slightly above elbow height
- Mouse should be next to the keyboard at the same height
- Shoulders relaxed
- Arms relaxed at sides with upper and lower arms forming a 90-degree angle
- Thighs parallel to the floor forming a 90-degree angle with the lower leg
- Lower back supported
- Keep wrists straight and fingers relaxed
- Feet flat on the floor
- Arms relaxed at sides with upper and lower arms forming a 90-degree angle

Top of monitor at or slightly below seated eye level
Telephony Services has a one-stop shop solution for your mobile telephony needs, conference calls and your desk phone.

[www.ucl.ac.uk/isd/telephony](http://www.ucl.ac.uk/isd/telephony)

**Telephony service**

If you need anything from a headset to a call centre or just some simple advice, email us on [is-telecoms@ucl.ac.uk](mailto:is-telecoms@ucl.ac.uk)

**Mobile phones**

Use our online service to choose from a range of handsets and contracts and manage your mobile phone. [www.ucl.ac.uk/mobiles](http://www.ucl.ac.uk/mobiles)

**Conference and collaboration**

We have conferencing solutions to provide a simple voice conference from your desk, a national or international option and options to share your desktop or provide full video conferencing. See online for further details.

Out of office voicemail messages

UCL's voicemail facility is not provided by default. You will need to request this for your number. There is no charge for voicemail accounts.

Dialling Colleagues

Many UCL buildings are connected together and we use extension numbers of 5 digits, please try to use the internal system rather than using the long exchange number.

Anything starting with a 9 is an external call.
Top tip!

How to find UCL contact numbers

You can find other contact numbers by using the UCL directory or the Global Address Book via your email program.

Find people using the UCL Directory

Go to: www.ucl.ac.uk/directory
Enter the name of the person you are looking for.

Find people in your email program

**Outlook Web App (OWA):**
Click on the People button (top right) > select Directory (left side).

**Outlook 2010/13:**
On the Home tab, in the Find group, click on Address Book.

**Outlook 2011 (Mac):**
On the Home tab, click on Find a Contact.

**Outlook 2016 (Mac):**
On the Home tab, click on Address Book.

Important numbers

- **UCL emergency number:** 222
- **UCL switchboard:** 100
- **Maintenance Emergency/Security Control:** 33333
- **ISD Service Desk:** 25000
- **Estates Helpdesk:** 30000
Tools to help you with your administrative functions
From finance to conference bookings.

Systems to help
Will you be performing admin functions as part of your role? You will likely need access to some of the systems we run to help you do your job.

Examples of some of the systems available to you are:

- Financial management
- HR processes
- Archiving and records management
- Alumni and fundraising information
- Recording visitors
- Booking rooms
- Portico – the student information System
- Creating an academic timetable

Access to admin services
You will need to register for some of these services. Help guides and information are available online.

Most administrative applications require your UCL user ID and password.
Top tip!

Use the services@UCL website to find admin services

Go to: www.ucl.ac.uk/services
You can list by:

- System
- Process or
- Unit

Once you start using services@UCL, the application will begin to remember the systems you have visited in the past; to enable you quick access back to those systems.
Get creative!
Your one-stop shop for all your creative and media requirements.

Design and photography
Comprehensive design and photographic service which supports UCL-wide learning & teaching, promotional and PR activities.

Poster production
Academic poster printing service – now expanded to include promotional and “exhibition quality” printing.

Media Production and Media Delivery
A broadcast quality service, offering location and studio production, in-house facilities, live streaming of events and media delivery through iTunesU and for 2016 – UCL MediaCentral

Digitisation and scanning service
State-of-the-art digitisation service by expert technicians and incorporating film, document and book scanning equipment which provide high quality digital imagery for research and archival purposes.

Imagestore and MediaCentral
Online image and video libraries
Content is mainly of UCL activities for use in print, web, presentations and teaching materials
www.imagestore.ucl.ac.uk
www.ucl.ac.uk/mediacentral
Top tip!

For Design...

Design: Be open minded, especially to new design concepts and ideas and always check that you are complying with the UCL Visual Identity guidelines. [www.ucl.ac.uk/visual-identity](http://www.ucl.ac.uk/visual-identity)

For Posters...

Posters: For academic posters, always provide both PowerPoint (.ppt) and PDF (.pdf) files where possible. However, remember that what you see on screen is not necessarily what you will see in print so allow time for amendments – which we are happy to help with.

For Photography...

Photography: We suggest, wherever possible, try to use professionally produced high resolution imagery. Your final output, will be much improved. We are here to help and can undertake photography for you, or if you prefer give advice on producing your own images. Image (on right) shows the UCL Pearson Studio.

For Video...

Video: The process can be time consuming, so contact us in plenty of time before you need your production, that way we can help you better plan and prepare. We also offer an equipment loan service.
Help with your website

Let us help you create a great website.

Will you be maintaining a website as part of your role?

We provide advice and assistance on all aspects of websites, from content management and user experience, through design and development, to training and on-going support.

And remember, your website is very important so make sure you spend time managing it!

So let us help you make your website as successful as possible.
There's a lot to consider when you decide to design or redesign a website including:

• What are the purposes of the website?

• Who are the users and what are their top tasks on the website?

• How do you write content that's suitable for the web?

• How can you make sure that the website has a high ranking in Google?

• Who will keep the website up to date?
IT for School of Life & Medical Sciences

Have you joined the School of Life & Medical Sciences? If so, we can help with your IT...

www.ucl.ac.uk/isd/it-slms

Being part of SLMS gives you access to a broad range of speciality IT services in addition to the central IT offerings.

Local IT Staff

IT for SLMS staff provide support to the faculties of:

- Life Sciences
- Medical Sciences
- Brain Sciences
- Population Health Sciences

Local contacts listed here: www.ucl.ac.uk/isd/itforslms/about/contact

IT Solutions

IT for SLMS can provide or facilitate a range of services across SLMS:

- **Research** – including secure data handling & information governance
- **Learning and Teaching** – including e-learning and audio visual support
- **Health Creatives** – providing clinical and general photography, design, web & app development, print and video services
- **Infrastructure** – including hardware, datacentres and related services.

Top tip!

How to find us...

IT for SLMS has a range of locally based support available centrally and across the School of Life and Medical Sciences.

To find out more visit the website at www.ucl.ac.uk/isd/itforslms

Health Creatives can be contacted directly on 020 7813 8212 and 020 7830 2357.
Need to report a problem?
The Service Desk is your first point of contact for all requests and queries.
Tel: 020 7679 5000 (internal: 25000)
Visit: DMS Watson Library, Malet Place
Email: servicedesk@ucl.ac.uk

Hours of support:
Telephone Support:
8:30am – 5:30pm
Monday – Friday
Out of Hours Telephone Support:
5:30pm – 8:30am
Monday – Friday, including overnight, weekends, all UK Bank Holidays and UCL closure days. (Note: vacation times vary)

DMS Watson Front Desk:
9:30am – 5pm
Monday – Friday

Other ways to find information
Online: www.ucl.ac.uk/isd/help
Follow us on Twitter: @uclisd
Service news: www.ucl.ac.uk/isd/news
Top tip!

Use the Service Desk Portal

The Service Desk portal is your single point for submitting a problem/request and you can track any outstanding tickets you may have open.

To access the portal, visit: www.ucl.ac.uk/isd/help